Chapter - IV
DESCRIPTION OF TOOLS
CHAPTER-IV
DESCRIPTION OF TOOLS

The present chapter is the heart of the whole research thesis. So far the focus has been on the history, scope, need and listing of elements, the introduction to different variables under study, the review of related literature, objectives and hypotheses of multimedia but now we come to actual multimedia cocktailing of these elements that is combining all the elements of multimedia together and delivering them in one go. It means the focus will be on the description of development of Achievement test on Environmental Awareness, Opinionnaire for teachers and Multimedia Learning Package (MMLP) developed by the investigator.

The present chapter deals with the description of tools.

For the present investigation, the following tools were used.

**Standardized Tools**

**Self Made Tools**
1. Achievement Test on Environmental Awareness. (Prepared by the Investigator).

**4.1 STANDARDIZED TOOLS**

**4.1.1 CATTELLS’ CULTURE FAIR INTELLIGENCE TESTS (1973)**

i) Description of the Test
The Culture Fair Intelligence Tests measure individual intelligence in a manner designed to reduce, as much as possible, the influence of verbal fluency, cultural climate and educational level. The tests, which may be administered individually or in
a group, are non-verbal and require only that examinees be able to perceive relationships in shapes and figures. Each scale contains four subtests, involving different perceptual tasks, so that the composite intelligence measure avoids spurious reliance on a single skill.

There are three scales in the Culture Fair series. The investigator has used scale -2 in the present study as it serves the purpose. It consists of four subtests.
In the first subtest, the individual is presented with an incomplete progressive series. His task is to select, from among the choices provided, the answer which best continues the series.
The second subtest is related to classification. The individual is presented with five figures. He must select one which is different from the other four.
The third subtest is related to complete the design or matrix presented at the left of each row matrices where the individual is asked to correctly complete the design.
The final subtest, conditions requires the individual to select, from the five choices provided, the one which duplicates the conditions given in the far left box.
Before each subtest, examples are given so that the task requirements are clear to the examinee.

ii) Administration of the Test

For conducting the test, test booklets and answer sheets were distributed to the pupil. The students were asked to fill in the information at the top of the answer sheet. Then all the necessary instructions were given to the students. Time limit was strictly adhered to.

iii) Scoring of the Test

For scoring the answer sheets, scoring key available for scale-2 was used. The stencil key was laid over the left hand side of the answer sheet using the 'check star' to adjust
it to the proper position. The total number of crosses ('Xs') showing through the holes was corrected and this number was recorded in the total score space on the answer sheet. These raw scores were then converted into normalized IQ scores using Table-2 (Cattle and Cattle) provided in the manual for scales 2 and 3 (Appendix-A).

The reliability of the test (Scale-2, Full test A+B) by Spearman Brown formula is 0.85 and K-R formula is 0.81. Direct concept validity of the test is 0.85.

4.1.2 SOCIO-ECONOMIC STATUS SCALE (SESS 2011)

i) Description of the Test
SES Scale is designed to measure social position of a person in Urban and Rural areas according to the lifestyle prevailing in both the regions. Socio-economic-status of a person in this scale refers to the “status of his/her family in relation to their level of socio-cultural participation, ability to influence mass, level of education, kind of occupation, financial position, health-wellbeing, lifestyle, level of aspiration, kind of gadgets, services and leisure facilities that the family enjoys.” This scale is an endeavour to ascertain the SES of an individual based on current social structure with new thinking.

This scale has been developed both in English and Hindi languages for Urban/Rural households. It is easy to be administered and acknowledges the social position of an individual in the society.

ii) Administration of the Test
The items and components of SES Scale comprised of 40 statements in all based on five different dimensions of socio-economic parameters. Distribution of items and components of SES Scale is given below in Table 4.1.
Table 4.1

Dimensions of Socio-Economic Status Scale

<table>
<thead>
<tr>
<th>Part</th>
<th>Dimensions of SES Scale</th>
<th>Items</th>
<th>Total Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>PART-I</td>
<td>Socio-Cultural Component</td>
<td>1 to 5</td>
<td>15+1</td>
</tr>
<tr>
<td></td>
<td>(+ information on caste)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PART-II</td>
<td>Economic Component</td>
<td>16 to 20</td>
<td>05</td>
</tr>
<tr>
<td>PART-III</td>
<td>Possession of Goods and Services</td>
<td>21 to 30</td>
<td>10</td>
</tr>
<tr>
<td>PART-IV</td>
<td>Health Component</td>
<td>31 to 35</td>
<td>05</td>
</tr>
<tr>
<td>PART-V</td>
<td>Educational Component</td>
<td>36 to 40</td>
<td>05+1</td>
</tr>
<tr>
<td></td>
<td>(+ information on Stream)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td></td>
<td><strong>40+2 = 42</strong></td>
</tr>
</tbody>
</table>

iii) Scoring of the Scale
Scoring process of the SES scale is easy, and objective. To get the total SES scores, the researcher is required to count the SES scores of the answer/options mentioned in the square box, which has been ticked ☑ by the respondent. In this way it saves time, money and labour. It also minimizes possibility of error of counting of total score by the researcher.

iv) Reliability of SES Scale
Reliability of the scale has been measured by split-half and test-retest method. In split-half method, reliability is .68 and in test-retest method, reliability is .86.

This scale was preferred by the investigator due to following reasons:

I) All the essential variables which determine the Socio economic status in a modern society were included in the scale.

II) The directions given are simple and easy to understand.

III) The test can be used under normal class room conditions easily and effectively.
v) Validity of Socio-Economic Status Scale

All the 40 items of socio-economic status has been evaluated by various Expert opinion of teacher educators and language specialists with regard to relevance of each items was sought. The expert opinion came out to be favourable in terms of the relevance of each item in the scale. The criterion validity came out to be 0.85 which is highly significant. (Appendix-B)

4.2 SELF MADE TOOLS ARE

4.2.1 ACHIEVEMENT TEST ON ENVIRONMENTAL AWARENESS
(Prepared by Investigator)

‘Achievement Testing' refers to the assessment of the outcomes of formal instruction in cognitive domain (Dwyer, 1982). It can also be thought of as a sample of indicator of a student's knowledge taken at a particular point of time or achievement test may be a sample of behaviour that provides opportunity for comparison with performance standard, as in criterion referenced testing, it aids both the teacher and students in assessing learning readiness, monitoring learning outcomes (Gronlund, 1977).

The researcher made a thorough survey of Achievement Test on Environmental Awareness in the current available material for Class VII students but could not locate an appropriate Standardized Achievement Test. Therefore, it was decided to develop an Achievement Test on Environmental Awareness in Environmental Science to evaluate the Students of class VII on knowledge, comprehension, application and skill on the topics selected for treatment. A study of research and non-research literature motivated and helped the researcher to reflect on the use of multimedia. The professional experience and expert opinion helped to develop the Achievement Test on Environmental Awareness.

Achievement Test on Environmental Awareness was prepared for all the five MMLPs consisting of 110 objective type questions in total and after try out the final draft had 90 questions. This Achievement test on Environmental Awareness covered all the important aspects of the lessons taught in the class by the researcher to the control...
group and experimental group both. The class VII students of experimental and control group were given printed achievement test and answer sheets. The following steps were followed for developing the tests:

(a) Planning the Test
Planning stage of the test tries to answer what content area is to be covered by the test? What type of items are to be included in the test and what are the objectives that are going to be tested?

The planning stage of a test should include the nature of the test items and the statement of conditions under which it will be administered. The Achievement Test was planned with the objective of measuring Achievement on Environmental Awareness in Environmental Science for students of class VII on selected topics. For the planning of Achievement Test on Environmental Awareness following points were taken into account:

(a) Determining the purpose of the test;
(b) Identification and defining the intended learning outcomes;
(c) Preparing the test specifications; and
(d) Constructing relevant test items;

Steps of preparing Achievement Test
1. Instructional objectives
2. Design
3. Blueprints

Instructional Objectives of the Test
For the purpose of constructing Achievement Test on Environmental Awareness, objectives were defined in behavioural terms from selected units of Environmental Science syllabus of class VII prescribed by CBSE. Since the major concern here was to test the academic achievement, accordingly, it was decided to test the four
major areas of cognitive domain, i.e., knowledge, understanding, application and skill. After determining the objectives, the learning outcomes were stated as observable terminal performance. In order to make sure that achievement test on environmental awareness measures a desired behavior, test specifications were developed covering the objectives and subject-matter selected to be taught during the experiment.

Content of the Test

The test covered the content of the following five units.

1. Environment and Natural Resources - Water
2. Natural Resource - Air
3. Natural Resource - Soil
4. Natural Resource - Forest
5. Effect of Human Activities and Steps for Conservation of Natural Resources

To decide the weight age to be given to different content area, objectives and different forms of questions, expert opinions of the Environmental Science teachers were taken into considerations.

Preparation of the Test Items

110 objective type items with wide range of difficulty were constructed from five units of Environmental Science syllabus prescribed by CBSE. Items were prepared in conformity with the Blueprint. While constructing items, it was ensured that no objective remained untested and language of the test items was understandable and unambiguous and the instructions were clear. The test items were arranged in the order of difficulty. The test items were arranged properly and assembled into the test. The preliminary draft in Achievement Test on environmental awareness was given to experts in education, which included experts in measurement and evaluation and experienced Environmental Science teachers. They were requested to give their opinion about the language and appropriateness of the items. Only those items were
selected which were having 80% unanimity. Items that were having difficulty in language were modified to simple language. Finally, 90 items constituted the Achievement Test on Environmental Science.

**Preparation of Directions to Test Items**

Appropriate directions to test items were prepared. The directions were clear and concise so that the students of class VII could understand them easily. As test was divided into sections, clear instructions were given in the beginning of each section. For objective questions, the control group and experimental group students were instructed to write the correct response in the given answer sheet.

**Preparations of Directions for Administration**

A clear and detailed direction as to how the test is to be administered was provided.

**Preparation of Directions for Scoring**

To facilitate the objectivity in scoring, scoring key was prepared for 5 topics of Environmental Science.

**First Try-Out**

The test was administered to 35 students of class VIII, Discriminating Power (D.P.) was computed for each item after forming top 27 per cent and bottom 27 percent group from the total subjects as suggested by Kelley (1939). The blue-print of the first draft of Achievement Test and distribution of discriminating powers (D.P.) was as seen in Table 4.2, 4.3 and 4.4. (Appendix- C&D)

Q 1 = Knowledge
Q 2 = Comprehension
Q 3 = Application
Q 4 = Skill
### Table 4.2
Blue Print of First Draft of Achievement Test on Environmental Awareness

<table>
<thead>
<tr>
<th>Chapters of Environment and Natural Resources</th>
<th>Cognitive Level of Objectives</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q₁</td>
<td>Q₂</td>
</tr>
<tr>
<td>Water</td>
<td>09</td>
<td>07</td>
</tr>
<tr>
<td>Air</td>
<td>06</td>
<td>08</td>
</tr>
<tr>
<td>Soil</td>
<td>10</td>
<td>04</td>
</tr>
<tr>
<td>Forest</td>
<td>10</td>
<td>09</td>
</tr>
<tr>
<td>Human Activities and Steps for Conservation</td>
<td>03</td>
<td>11</td>
</tr>
<tr>
<td>Total</td>
<td>38</td>
<td>39</td>
</tr>
</tbody>
</table>

### Table 4.3
Blue Print of First Draft of Items in Achievement Test on Environmental Awareness

<table>
<thead>
<tr>
<th>Chapters of Environment and Natural Resources</th>
<th>Cognitive Level of Objectives</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q₁</td>
<td>Q₂</td>
</tr>
<tr>
<td>Water</td>
<td>1,10,23,24,35, 36,38,69,73</td>
<td>02,33,37,61, 62,70,107</td>
</tr>
<tr>
<td>Air</td>
<td>04,05,40,65, 82,100</td>
<td>06,07,41,42, 64,81,83,101</td>
</tr>
<tr>
<td>Soil</td>
<td>28,29,43,45,46, 52,66,72,84,85</td>
<td>08,09,44,67</td>
</tr>
<tr>
<td>Forest</td>
<td>12,13,30,32,47, 50,51,88,90,91</td>
<td>14,15,16,17,31, 49,53,56,98</td>
</tr>
<tr>
<td>Human Activities and Steps for Conservation</td>
<td>26,48,97</td>
<td>19,20,21,34,54, 55,77,87,89,96, 99</td>
</tr>
<tr>
<td>Total</td>
<td>38</td>
<td>39</td>
</tr>
</tbody>
</table>
Distribution of discriminating powers of items was calculated by formula:

\[ DP = \frac{R_u - R_l}{0.5N} \]

- \( R_u \) = No. of correct responses in upper group.
- \( R_l \) = No. of correct responses in lower group.
- \( N \) = Total no. of correct responses.

**Table 4.4**

**Distribution of Discriminating Powers (D.P.) of Items of First Draft of Achievement Test**

<table>
<thead>
<tr>
<th>Discriminating Powers</th>
<th>Frequency</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40 and above</td>
<td>60</td>
<td>Very Good Items</td>
</tr>
<tr>
<td>Between 0.30 and 0.39</td>
<td>30</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>Between 0.20 and 0.29</td>
<td>05</td>
<td>Needs Improvement</td>
</tr>
<tr>
<td>&lt;0.19</td>
<td>15</td>
<td>Very Poor</td>
</tr>
<tr>
<td>Total</td>
<td>110</td>
<td></td>
</tr>
</tbody>
</table>

**Second Try-Out**

The revised version of the achievement test was administered on another group of 35 students of class VIII. Again Discriminating Power of 90 items was computed. The distribution of discriminating powers can be seen in Table 4.5

**Table 4.5**

**Distribution of Discriminating Powers (D.P.) of Items of Final Draft of Achievement Test**

<table>
<thead>
<tr>
<th>Discriminating Powers</th>
<th>Frequency</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40 and above</td>
<td>60</td>
<td>Very Good Items</td>
</tr>
<tr>
<td>Between 0.30 and 0.39</td>
<td>30</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>Between 0.20 and 0.29</td>
<td>-</td>
<td>Needs Improvement</td>
</tr>
<tr>
<td>&lt;0.19</td>
<td>-</td>
<td>Very Poor</td>
</tr>
<tr>
<td>Total</td>
<td>90</td>
<td></td>
</tr>
</tbody>
</table>
In the light of the results as seen in Tables 4.2, 4.3 and 4.4 out of 110 items, 20 items below the discriminating power of 0.30 were dropped and 90 items were retained. These items were improved with respect of languages and description. This led to the preparation of final draft of the Achievement Test. This draft of achievement test comprised of 90 items. The table of specifications of blue-print for achievement test is presented in the Table 4.6 and the numbers of retained items are shown in Table 4.7

Table 4.6
Blue Print of Final Draft of Achievement Test

<table>
<thead>
<tr>
<th>Chapters of Environment and Natural Resources</th>
<th>Cognitive Level of Objectives</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q$_1$</td>
<td>Q$_2$</td>
</tr>
<tr>
<td>Water</td>
<td>06</td>
<td>03</td>
</tr>
<tr>
<td>Air</td>
<td>05</td>
<td>04</td>
</tr>
<tr>
<td>Soil</td>
<td>07</td>
<td>03</td>
</tr>
<tr>
<td>Forest</td>
<td>08</td>
<td>04</td>
</tr>
<tr>
<td>Human Activities and Steps for Conservation</td>
<td>05</td>
<td>13</td>
</tr>
<tr>
<td>Total</td>
<td>31</td>
<td>27</td>
</tr>
</tbody>
</table>

Q$_1$ = Knowledge
Q$_2$ = Comprehension
Q$_3$ = Application
Q$_4$ = Skill
Table 4.7
Number of Items retained in the Final Draft of Achievement Test on Environmental Awareness at Different Cognitive Levels of Objectives

<table>
<thead>
<tr>
<th>Chapters of Environment and Natural Resources</th>
<th>Cognitive Level of Objectives</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q₁</td>
<td>Q₂</td>
</tr>
<tr>
<td>Water</td>
<td>01,20,30,31,33,55,</td>
<td>02,32,56,</td>
</tr>
<tr>
<td></td>
<td>04,05,35,52,39,68,69,</td>
<td>06,07,36,37,</td>
</tr>
<tr>
<td></td>
<td>10,21,25,38,39,41,42,43,72,</td>
<td>08,09,53,</td>
</tr>
<tr>
<td></td>
<td>12,13,27,40,41,42,43,72,</td>
<td>14,15,26,71,</td>
</tr>
<tr>
<td></td>
<td>23,58,59,73,74,</td>
<td>17,18,28,29,44,45,50,65,67,79,80,81,87,</td>
</tr>
<tr>
<td>Total</td>
<td>31</td>
<td>27</td>
</tr>
</tbody>
</table>

Standardization of Achievement Test

90 Items constituted the final form of the Achievement Test on Environmental Awareness. The Achievement Test was further standardized by experimental validation of the test that included establishing reliability and validity.

Reliability of the Test

Reliability is one of the most important pre-requisite of a measuring tool. It is the degree of consistency between two measures of the same test. The reliability of a test refers to the extent to which a test measures consistently from one administration of the test to another. According to Fraenkel & Wallen (1993) method of the reliability
refers to the consistency of the scores obtained as how consistent they are for each individual from one set of items to another. The reliability of the test was measured by split half method. The co-efficient of the Reliability of the test, as found by split half method was 0.85 which indicates that the test is highly reliable. According to Fraenkel and Wallen (1993), reliability coefficients of 0.70 or higher are acceptable for research purposes. The reliability co-efficient of the present test was 0.85. Therefore, the achievement test may be considered fairly reliable.

Validity of the Achievement Test
Validity is a concern for the relationship between, the purpose set to achieve, on the one hand, and the efforts made, the means employed and what these efforts means actually achieve, on the other. The Validity of the Achievement Test constructed for the study was taken for granted because this is in accordance with Guilford (1971) who said, "There are some measures whose validity is taken for granted, for example, Achievement Test scores."

Content Validity
Regarding the method of establishing the validity of the test, Mouly (1970) stated, 'At the most elementary level, it is necessary for all the test' to have content validity, i.e., each question must be related to the topic under investigation, there must be an adequate coverage of the overall topic, the question must be clear, unambiguous, etc. The most adequate approach to validation consists of checking the agreement between the responses elicited by the question against the criterion. The present achievement test was validated against the criterion of content validity. Content validity is the most important criterion for the usefulness of the test, especially of an achievement test. It is a measure of the match between the content of the test and the content of "teaching" that preceded it. The measure is represented subjectively by the researcher after a careful process of inspection comparing the content of the test with the objective of the course of instruction. Thorndike (1975) maintained that problem of content validity is parallel to the problem of preparing a
Blue print for a test and then building a test to match the Blue-print. So, the Achievement test on environmental awareness was found to possess Content Validity as there was correspondence between the table of specifications and test items.

**Construct Validity**
The construct validity refers to an analysis of "effective expression" of items in the test. Selection of ideas to be presented, organization of ideas for presentation, paragraphing, writing effective sentences, effective use of words, form and style to message are the main components for analysis of effective expression (Thorndike and Hagen; 1955).

In the present study the investigator organized the ideas of the selected topic in a logical order and gave adequate representation to all the concepts. The style and language of sentences was simple. Effective use of words was made by selecting the precise meaning and variety. Narration in proper style with simple words constituted readable and comprehensible sentences. Thus, the achievement test prepared by the investigator fulfilled the requirements for effective expression. Hence, the test has good construct validity.

**Final Form of the Test**
The final form of the Achievement test on Environmental Awareness in Environmental Science contained 90 items.

The final test along with the scoring key is given in (Appendix –E)

4.2.2 **OPINIONNAIRE FOR TEACHERS**

Opinionnaire - Opinionnaire refers to a formal statement or estimation of professional advice. In the context of the present study, the Opinionnaire aids the researcher in assessing the effectiveness of Multimedia method of Instruction by using Multimedia Learning Package in terms of content, presentation and its utility for Teachers. It also helps in studying the role of MMLPs in creating the learning
readiness, monitoring learning process, diagnosing learning difficulties. It also helps in evaluating the acceptability of MMLPs by Teachers to further judge the effectiveness of the Multimedia method of instruction as compared to the conventional method of instruction. A thorough literature survey of Opinionnaire available for Teachers was done but the researcher could not locate any such appropriate Opinionnaire based on MMLP catering to the topics selected for the study. Hence it was decided to develop an Opinionnaire for teachers to seek their opinion on the MMLPs.

An Opinionnaire was developed to elicit the opinions of the teachers to determine the effectiveness and acceptability of the Multimedia method of instruction for developing environmental awareness in teaching Environmental Science. An Opinionnaire consists of items with three alternative responses at the 3 point rating scale (Agree, Disagree, and Undecided) i.e. a score of 1, 0 and 0 were assigned to alternative responses respectively. At the end of the Opinionnaire, a column for remarks was made. The Opinionnaire was submitted to the four experts along with the design of the Multimedia Learning Package for establishing the validity. The format was accepted by the experts. The opinion of 10 Teachers, teaching at Pathfinder Global School, Pataudi, District – Gurgaon was obtained.

Development and Description of Opinionnaire

The teacher is considered as the pivot upon which lies the success or failure of an educational programme. The Opinionnaire was meant to obtain the information about the effectiveness of the Multimedia method of instruction with Multimedia Learning Package for class VII students, for developing environmental awareness in Environmental Science.

After discussions with educationists, supervisor and Educational Technology specialist, the following criteria were delineated for multimedia package evaluation:

The evaluator criteria of Multimedia Package:

i. Content characteristics

ii. Instructional characteristics
iii. Technical characteristics
iv. Management characteristics

The Evaluatory criteria of Multimedia Package

(i) Content Characteristics The presentation of content was viewed from the aspect
   a) The appropriateness of content,
   b) Extensive uses of examples and illustrations to clarify content,
   c) Appropriate language, etc.

(ii) Instructional Characteristics The methods, strategies, etc. focused upon delivering content were considered as follows;
   a) Logical presentation of the content,
   b) Motivation,
   c) Ability levels of students,
   d) Self-pacing, etc.

(iii) Technical Characteristics Some techniques used in enhancing the learning - competencies of students as;
   a) Screen display of content,
   b) Graphics/animation,
   c) Music,
   d) Video, etc

(iv) Management Characteristics Dealt with management characteristics such as; ease in use of MMLP, test items, etc.
The Opinionnaire comprised of two parts

Part A - aimed at eliciting information from the teachers with regard to Name, Sex, Age, Educational qualification, Professional Qualification, Designation, Name of the school, Teaching Experience, Subject taught, Classes taken, Teaching Background and Methodology used by them in the class room.

Part B - was meant for obtaining information regarding the MMLPs Multimedia Learning Package used and their opinions on the various aspects, relevance and effectiveness of the Multimedia method of instruction for Teachers.

The following steps were taken for developing the opinionnaire

Planning the test

Planning stage of framing opinionnaire focuses on the areas to be covered by the opinionnaire which may also include the listing of items and the objectives for the opinionnaire. This stage was very important because it threw light on the core areas of MMLP. The opinionnaire under reference was planned for the teachers teaching Environmental Science to develop environmental awareness in class VII students. The
main objective was to seek their opinion regarding their statements on the Multimedia Learning Package for class VII students. The planning of opinionnaire aims at:

- Determining the purpose of opinionnaire
- Identifying and defining the intended teachers opinion.
- Preparing the opinionnaire specifications and
- Constructing relevant items for the opinionnaire

For constructing Opinionnaire, the objectives were outlined from the MMLPs of selected topics of Environmental Science of class VII. The major concern was to seek opinion of the Teachers.

**Objective of the Opinionnaire**

To find out the effectiveness of MMLP for Teachers teaching by the multimedia method of instruction. The opinionnaire covered the following areas of the MMLP.

- Content
- Presentation
- Benefits to students (Class VII)
- Benefits to teachers

**PREPARATION OF OPINIONNAIRE ITEMS AND FIRST TRY OUT**

**Constructions of statements-** The following steps were followed in constructing items for the opinionnaire

Development of statements - a set of questions that on the face of it seemed to measure the relevant concepts were selected to reflect orientation to the Multimedia package evaluation. A total of sixty items encompassing the four criteria were submitted to educationists and experts of educational technology. They were requested to judge the items in terms of

i) Whether any important aspects of multimedia package evaluation were left uncovered.

ii) Whether the items were relevant and suitable for realising the objectives of the study.

iii) Whether any of the items could be improved by rewriting.
iv) Whether some new items needed to be added.

60 statements were framed to elicit the views of teachers on a three-point rating scale. The preliminary draft of opinionnaire was framed and given to 5 teachers of Environmental Science after showing the MMLPs. They were requested to give their opinion about the language and appropriateness of items based on the MMLP. Only those items were selected which were having 80% unanimity. 44 statements constituted the Opinionnaire after first try-out. As the table 4.8 has shown that if discrimination index is either equal to or greater than 0.30 (> 0.30) than the item discriminate otherwise not. So, the investigator selected the statements discrimination index of 0.30 or above.(Appendix-F)

Table 4.8
Interpretation of Discrimination Index of each item of Opinionnaire

<table>
<thead>
<tr>
<th>S.NO.</th>
<th>Discrimination Index</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Below 30%</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>Good Discrimator</td>
</tr>
<tr>
<td>4.</td>
<td>80%- 100%</td>
<td>Best Discrimator</td>
</tr>
</tbody>
</table>

Table 4.9
Discrimination Index after First try out shows 44 items above 30%

<table>
<thead>
<tr>
<th>S.NO.</th>
<th>Discrimination Index</th>
<th>Item No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Below 30%</td>
<td>3,5,9,11,20,23,25,30,35,37,42,45,48,51,53,58.</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>1,4,6,7,8,10,12,13,14,17,19,21,24,26,27,31,32,33,34,36,38,39,40,41,43,44,46,52,56,59</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>2,16,18,22,28,47,49,50,55,60</td>
<td>Good Discrimator</td>
</tr>
<tr>
<td>4.</td>
<td>80%- 100%</td>
<td>15,29,54,57</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>
SECOND TRY-OUT

The opinionnaire was tested and tried out with a group of another 10 teachers. Out of 44 statements another 4 were rated below the acceptability level, while 40 statements were selected for the final draft. The blue-print of the final draft of opinionnaire and distribution of discriminating powers is given in the Table 4.10

**Table 4.10**

**Discrimination Index after Second Try Out**

<table>
<thead>
<tr>
<th>S. no</th>
<th>Discrimination Index</th>
<th>Item No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Below 30%</td>
<td>3, 5, 7, 9, 11, 20, 23, 25, 30, 33, 35, 37, 41, 42, 45, 48, 51, 53, 56, 58</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>1, 4, 6, 8, 10, 12, 13, 14, 17, 19, 21, 24, 26, 27, 31, 32, 34, 36, 38, 39, 40, 43, 44, 46, 52, 59</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>2, 16, 18, 22, 28, 47, 49, 50, 55, 60</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4.</td>
<td>80% - 100%</td>
<td>15, 29, 54, 57</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>

**Final form of Opinionnaire**

i) After going through 2 try outs the final form of opinionnaire has 40 statements

**Table 4.11**

**Distribution of Final Items in Opinionnaire**

<table>
<thead>
<tr>
<th>S.NO.</th>
<th>Category</th>
<th>No. of Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Content Characteristics</td>
<td>10 Items</td>
</tr>
<tr>
<td>2.</td>
<td>Instructional Characteristics</td>
<td>17 Items</td>
</tr>
<tr>
<td>3.</td>
<td>Technical Characteristics</td>
<td>5 Items</td>
</tr>
<tr>
<td>4.</td>
<td>Management Characteristics</td>
<td>8 Items</td>
</tr>
</tbody>
</table>
Open ended questions were included at the end of opinionnaire to enable the Multimedia Package evaluators to identify overall strengths and weaknesses of the Multimedia Learning Package. On the basis of 2 tryouts the Investigator categorizes each item according to their discrimination index as shown in the Table 4.11.

**Reliability** - The reliability is the property of an item which reflects its consistency if the same opinionnaire is given second time, similar results must be achieved. The present form of opinionnaire stood firm on the two trials. The reliability of the opinionnaire was measured by split-half method. The co-efficient of reliability as found by split half method, was 0.91 which indicates that the opinionnaire is highly reliable.

**Validity** - Validity of a test or opinionnaire is the extent to which it measures what is attempted to be measured. This implies that the opinionnaire here should conform to the objectives of the testing. It was found that the statements of the opinionnaire were framed with the objective to seek the opinion of the Environmental Science teachers on MMLPs. The opinionnaire was given to 4 Environmental Science experts and they made few suggestions which were incorporated, but it was widely accepted by the experts and the response from teachers further established the validity of the opinionnaire. The present opinionnaire is reliable, valid, covers all the elements catering to the objective, length of the opinionnaire is optimum, it is easy to administer, has scorability and above all its comprehensiveness takes care of all the aspects and nothing goes un-escaped.

After the final draft was accepted these opinionnaires were filled up by the teachers providing the required information in different columns. Teachers were required to provide answers to the questions where some information is sought by writing in the space provided for it. They had to tick the right column where their opinion was sought. They had to tick one of these columns (agree/ disagree/ undecided) as per their choice. The teachers were requested to make information as elaborate and descriptive as possible to enable the researcher to understand the effectiveness of the
Environmental Science Multimedia Learning Package for developing environmental awareness in elementary school children. The opinion was sought for further planning new inputs and improvement of existing Multimedia Learning Package. Their comments were sought on the issues like - the strong points and the weak points or problem areas of this Multimedia Learning Package, their suggestions for making this Multimedia Learning Package better in future. (Appendix-G)

4.2.3. DEVELOPMENT OF MULTIMEDIA LEARNING PACKAGE
This is the heart of the whole research thesis. It focuses on the actual multimedia cocktailing of elements (text, audio, video, animation, and graphics) that is whining all the elements of multimedia together and delivering them in one go. It also highlights the development of Multimedia Learning Package (MMLP) and its various stages. Since no syllabus based, MMLPs were available, so the investigator decided to develop herself the Multimedia Learning Package to teach by multimedia method and bring environmental awareness among elementary school children. The development of MMLPs was a rigorous process and it had 3 major stages.

4.3.1 MULTIMEDIA LEARNING PACAKAGE DEVELOPMENT STAGES
Step-1 Development of Multimedia Learning Package
Development of Multimedia Package included the following three major stages.

1. Concept
2. Design
3. Production

Figure 4.2 Multimedia Learning Package Development Stages
**Concept Phase (First Stage)**

Every Programme and project begins with a concept, so MMLP is no exception. An MMLP concept is the concise definition of the programme that can be designed and produced as per the specific requirement of the target group.

A clear concept is important because it lays foundation for an effective Multimedia Learning Package. Hence changing the concept during any subsequent stages can turn disastrous. So the researcher needed to be very clear about the concept because any change at later stage could have altogether altered the direction and constitution of the Multimedia Learning Package.

---

**Figure 4.3 Basic questions at Concept stage**
Some basic questions asked at this stage were

1. What will it be about? (Syllabus e.g. Environment and Natural Resources)
2. What should it be called? (Title of the MMLP e.g. Water, Air, Soil, Forest)
3. Who will be the user? (Audience/student- Class VII)
4. What do we want to give the user? (text, animation, graphics or audio)

**Significance of Plan Approach at Concept Stage**

The concept phase was crucial because it had impact on both design and production and the overall shape of the proposed Multimedia Learning Package. So careful thought was given to the implications of the concept, for instance, including heavy layering or extra information was avoided, since it could lead to problems at the designing and production stage.

Design directly gets affected by any inclusion or exclusion of test and graphics thereby affecting the production which may over extend itself as resourcing and configuration issues also arise because of any additional considerations at the concept stage. It is always recommended that a clear plan approach should be undertaken.

![Plan Approach at the Concept Stage](image-url)

**Figure 4.4 Plan Approach at the Concept Stage**
Thus a clear plan approach was undertaken by the researcher incorporating the following points at the Concept Stage:

- Aims and objectives of the MMLP
- MMLP length and duration
- Selection of the title
- Brief content outlines
- Writing of Instructional objectives
- Outline of proposed methodology was framed
- Description of proposed application (format, media, etc.)
- Content levels (e.g., general, specific, as per syllabus)
- Target audience (e.g., class or level of students)
- Budget (e.g., class or level of students)

So it is the proper development and the understanding of the concept that stands behind every successful MMLP apart from skills and resources.

**Design Phase** (Second stage)

Design is a complex area in the development of multimedia, however it is often recommended to keep the design simple and adhere to usability guidelines wherever possible. This means that design elements must be comprehensible and support the drive for user intuitiveness. Consistency is also essential for design. Any design features should adhere to usability standards. So an utmost care was taken in keeping the consistency at all steps.

Following points were taken care of while designing the Multimedia Learning Package:

List of actions addressed at the Design Stage:

- Designing a script
- Storyboard, the content and screen elements were short listed.
- Media type, format, standards were specified.
- Flow chart of components was constructed.
- Images, graphics, animation items, audio and Video to be included were decided.
- Consistency in layout (e.g. design, colour, etc.).
- Consistency in terminology was maintained (e.g. menus, commands).
- Consistent titling / headers were done.
- Font size was made readable.
- Content layout was kept sensitive to screen size / view area.
- All images had descriptive alternative text (e.g. ALT tags)
- Simple background colours were used to allow enough contrast for users with vision disability.
- Video and audio clips had text equivalent.

**Elements of a Good Script for a Multimedia Learning Package**

Following points were being taken care of by the researcher while writing the script of MMLPs:

- An attractive start
- Clarity of concept
- Objective based content
- Known to unknown approach
- Interactive in nature
- Simple language
- No tricks
- Easily understandable technique
- No ambiguity
- Smooth transition
- Component of humour / fun
- Re- Enforcement
- Smooth Closure
1. Production Phase (Third stage)

The production period is dependent on the concept and design processes; being harmonized through agreement in appropriate resourcing, scoping and development time. It was thus essential to plan out the issues of work flow, and that the researcher recognized the projected deliverables and outcomes in the production stage, in the light of objectives desired at the concept stage. Mapping of milestones was done and activities were minutely monitored. Additionally a post production period was included in the overall development plan for quality assurance, testing, tweaking and evaluation. So, production stage was the stage of implication.

The production phase, including post production, had taken into consideration the following:

- Production of MMLPs including visual, audio, animation, graphics and video.
- Mapping milestones.
- Workflow, Progress reporting and monitoring.
- Testing with target audience.
- Evaluation (production and post production)
Incorporation of modification on the basis of feedback.
Review processes to see the effectiveness of the programme.

### 4.3.2 STEPS OF DEVELOPMENT OF MULTIMEDIA PACKAGE

The following list provides an overview of the various stages that crossed in developing MMLP:

1. **Data Gathering**
2. **Navigation Method**
3. **Media Contents**
4. **Interface designing**
5. **Storyboard**
6. **Authoring**
7. **Data Delivery**

#### Navigation Method
- Linear
- Non-Linear

#### Media Contents
- Text
- Audio
- Graphics
- Animation
- Video

#### Interface Designing
- Backgrounds
- Buttons and Icons

#### Storyboard
- Environment & Natural Resources
  - Air
  - Soil
  - Forest
  - Human Activities and Steps for Conservation of Natural Resources

#### Authoring
- Page-Based Authoring
- Time-Based Authoring

#### Delivery
- CD-ROMs
- Pen Drive

Figure 4.6 Steps of Developing MMLP.
4.3.2.1 Data Gathering

Data Gathering was the first step and included following phases-

- Information Collection
- Analysis and Filtering
- Organization
- Verification

![Figure 4.7 Steps for Data Gathering](image)

**Stages-**

1. **Information Collection** - At this stage the researcher collected all the information relevant to MMLPs. The required content information was collected from the books as per syllabus of class B.Ed. and it was further enriched from the web and library. After collecting it analyzed, filtered and organized.

2. **Information Analyzed and filtering** - Filtering is a process of deciding which information is reliable and authentic and which is not. At this stage the researcher filtered the information and this helped in deciding the volume and depth of the information needed for the MMLPs. Not all the information gathered was found useful for the MMLP. So the data was to be edited and deleted altogether.

3. **Data Organization** - The filtered data was keyed in to computer for further processing. A blueprint of the MMLP got ready. At this stage the researcher
got a fair idea about how to MMLP would be evolved in terms of content. The information was organized in a logical and sequential manner. This stage was the backbone of the MMLP development.

Stage-4 Data Verification and Authentication- Once all necessary information had been collected and organized, it was verified and authenticated as per the specification of the syllabus and necessary correction was made.

4.3.2.2 NAVIGATION METHOD

Linear structure approach was used for navigation. It was the simplest approach where the user moves through a sequential straight line path, one part after another. Here the user had the option of moving one step upwards and backwards.

![Figure 4.8 Navigation Method- Linear](image)

4.3.2.3 MULTIMEDIA CONTENTS

Once the contents and navigation structure had been organized, the attention was paid to multimedia elements required for development of MMLPs. These included elements of multimedia namely: audio, video, text and animation.
Table 4.12

Multimedia Elements and Contents

<table>
<thead>
<tr>
<th>Media Elements</th>
<th>Typical Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Background music, background voice.</td>
</tr>
<tr>
<td>Video</td>
<td>Video on all the five topics were taken, tree plantation and practicing of 3 R's Reduce, Reuse and Recycle.</td>
</tr>
<tr>
<td>Text</td>
<td>In all MMLPs content specific for title, main body and conclusions in all slides</td>
</tr>
<tr>
<td>Graphics</td>
<td>Backgrounds, pictures, images, widely used in all MMLPs</td>
</tr>
<tr>
<td>Animation</td>
<td>Used for titling and highlighting effects as used in all MMLPs e.g. animated pictures in Air, animated picture of human being in water animated picture to show conservation of resources. Animated Mascot owl used in many MMLPs.</td>
</tr>
</tbody>
</table>

Multimedia Learning Package were developed using various elements of multimedia audio, video, text, graphics and animation.

Text

Text has played an important role in development of MMLPs. The extent to which text have been in MMLPs depend upon three major factors-

- Nature of the MMLPs (Growth and Development, Learning and Motivation, Personality and Basic Statistics)
- The subject/content (specific title and proportion of the topic taken)
- The treatment of the subject/content (heavy graphics/ light graphics/ heavy text/ light text)

Text have been used in MMLPs for different purposes-

- Title texts
- Body texts
- Menu
- Miscellaneous texts

The design rules that governed multimedia text largely depend upon the context in which particular text appeared. In general the title texts were bigger in size and were employed brighter colours than the body texts.
Designing text involved two basic aspects of information that were-Content and display.

- Content covered the matter that was being presented.
- Display covered how that matter was being presented.

The three parameters that controlled the display design of multimedia texts were –

- Fonts
- Font colours
- Backdrop (Background)

It was noticed that while the font affected the profile of the displayed texts, colours and background affected the overall appeal of the same.

**Graphics**

Graphics play a pivotal role in multimedia applications. The maxim’s picture is worth a thousand words; is so factual that one cannot underestimate the impact of visual over plain text or audio, in the context of multimedia. Graphics in multimedia represent a collective terminology that includes all kinds of still pictures like images, photographs and art works used in MMLPs applications. It doesn’t include any entities with dynamics and movements like animation and videos. Graphics used in MMLPs were characterized by certain attributes which made these MMLPs effective.

- Graphics were kept as simple and appealing.
- They fittingly captured the mood of the title.
- They were designed and selected suitably to fit the overall theme of the design.
- They were even used as background image or moving from one concept to other.
- They were developed in exact concurrence with other forms of media presented like texts videos so that all these elements fitted together as one seamless stream of information.

Type of graphics imagery used in MMLPs fall under any one of the following categories:
Graphics are important companions to information, when suitably presented. In present 5 MMLPs 20-30% of space was dedicated to graphics and the rest was filled by textual information. Picture can hold the attention of viewers longer because of its interactivity and wide variety. Pictures have been used by the researcher to cover the various aspects of the selected topics. For example the Bio-Geo-Chemical cycles could be explained better with visuals.

Audio
Audio plays a vital role in the making of an MMLP. In all the 5 MMLPs audio has been widely used. It has been put in the form of natural sounds, music and narrations. While the MMLPs audio recording was a serious business, it needed great effort and expertise.

The three major steps of audio input are:

- Sound recording
- Sound editing
- Sound delivery

Step One
Sound Recording – Sound recording was done taking all the precautions like when microphone based recording was done, a place was selected with least noise disturbance from outside. The microphone was connected to the mic-in – jack of the sound card of the computer and sound was recorded. After the recording got over the step button was pressed and the sound file was saved on computer using one of the media players.

Step Two
Sound Editing – sound editing demanded even more expertise than the sound recording. Effective sound editing demanded a great deal of creativity and
timing. It was the stage where all the errors of sound recording were noticed and corrected. The noise reduction was done in order to enhance the audio quality/volume or dullness in some places.

**Step Three**

**Sound Delivery**- Audio has been delivered using MP3 or Microsoft WAV formats.

Audio has served several purposes.

- It offered commentary that supplemented text
- Audio files being smaller to load than video and prove less fidgety than video plug-ins.

So sound has been an essential element of Multimedia Learning Packages. It was therefore, very important for the researcher to understand the nature of sound, its components and characteristics, by using commentary and powerful narration, combining the sound effects, music dialogues, wonderful and fascinating pictures could be created.

Human voice especially the voice of teacher in the form of narration, commentary or recitation has worked like magic and has made the Multimedia Learning Package interesting and fascinating. Similarly the background music and suggestive music (happy, sinister depending upon the nature of the package) has made it more effective. Atmospheric sound effects, sound of the wind, or special noises etc. have been used to enrich and emphasize the impact and meaning. Thus sound has provided rich and enormous possibilities to enrich the teaching learning process.

Audio has been used in all the Multimedia Learning Packages and it has added to the effectiveness of MMLPs.

**Video**

Video has been delivered using media player. Video proved to be an effective Supplement to text and images and provided enhanced experience. In the
Multimedia Learning Package (Water, Air, Soil, Forest and Consequences of Human Activities and steps for Conservation) video clippings have been used to explain Different topics.

**Animation**

Animation has derived from the Latin word meaning “bring to life”. Rapidly changing the image on the screen to create the illusion of motion is called animation. In other words, modeled objects are brought to life in animation. The researcher has used an animated mascot ‘The Owl’ in the MMLP. Although animation is considered synonymous with motion, it covers all changes that have a visual effect. It thus includes the time varying position, shape, colour, transparency, structure and texture of an object. To animate something is, literally, to bring it to life. A computer based animation performed by a computer using graphics tools to provide visual effects.

Animation has been used by researcher for:
- showing concepts or status in transition
- indicating dimensions
- visualizing 3D structures

Educationists have found that children love animation by nature. In the Multimedia Learning Package animation effect was added for explaining different concepts. It was highly stimulating and brought in the feeling of participation in the learning package. The viewers were completely involved and remained active. It also helped in the retention of the attention of the viewers.

### 4.3.2.4 INTERFACE DESIGNING

At this stage, background and buttons to link sides was infused.

**Technical PowerPoint Vocabulary for Multimedia**

Every instructor who wants to develop multimedia programme needs to familiarize with the vocabulary of Microsoft power point. Following are the few common terms used throughout while developing an MMLP (a power point presentation).

- **Slide**: An individual screen in a slide show.
**Presentation File:** The file you save to disk that contains all the slides, speakers, notes, handouts, etc. that make up your presentation.

**Object:** Any element that appears on a PowerPoint slide, such as clip art, text, drawing charts, sounds and video clips. You can refer to a clip art object, a text object, a title object, a drawing object, etc.

Anything you put on a PowerPoint Slide is called an object

**Slide Show:** A series of slides displayed in sequence. A slide show can be controlled manually or automatically.

**Transition:** A special effect used to introduce a slide during a slide show. For example, you can fade in from black, or dissolve from one slide to another.

**Development of Multimedia Package using PowerPoint**

The toolbars helped the investigator perform various tasks
The toolbar contain graphically illustrated buttons that you click to perform specific task in a program. Power Point 97 has four main toolbars, which can help you create your presentation quickly and easily.

The *Standard Toolbar* is located at top of the PowerPoint window, below the menu bar. It has buttons for common tasks such as saving, printing, checking spellings and inserting charts and tables.

![Standard Toolbar](image)

Use the standard Toolbar of common tasks

The *Formatting Toolbar* is located just below the Standard toolbar. Most of its buttons are for formatting text. Use these buttons to change the font type and size, make text bold or italic, indent text and insert bullets.

![Formatting Toolbar](image)

Use the Standard Toolbar to rearrange the text

The *Drawing Toolbar* is located at the bottom of the Power Point window. It has tools for drawing shapes, adding shapes, adding lines and curves and inserting text boxes and Word Art. It also has buttons for manipulating and formatting the objects you draw.

![Drawing Toolbar](image)

The drawing Toolbar lets you create fun shapes and graphics
The Common Task toolbar is initially a floating toolbar. That it is not anchored to an edge of the Power Point window. Use this toolbar to create a new slide, change the layout of a slide, or apply a design.

The Common tasks Toolbar is a floater

The investigator moved the toolbars to new locations

All Power Point toolbar Can moved or docked to any side of the Power Point window. As well, docked toolbars, including the Standard Toolbar, the Formatting Toolbar, and the drawing Toolbar can be converted to floating toolbars. A move handle on the left or top of the toolbar indicates that the toolbar is docked. A title bar indicates that the toolbar is floating.
Here's how to move one of the toolbars to a new location:
1. Clicking the move handle on a docked toolbar or click the title bar on a floating toolbar.
2. Holding down mouse button, drag the toolbar to the new location.

**The investigator docked the toolbars to create more working area:**
The investigator docked the Common Task toolbars to top of the Power Point window. This will give you more working area on your Power Point window.
1. The investigator clicked the title bar on the Common Task toolbar.
2. Then dragged the toolbar upwards, until the toolbar outline snap into place along the page of the program window.
   The handles that appeared on the toolbar confirmed that the toolbar had been successfully docked.

**Adding and removing toolbars**
Power Point has several other toolbars to help you accomplish your tasks.
The *Picture Toolbar* has several buttons that are useful when you work with images. There are buttons for Contrast, Brightness and Cropping. This toolbar will automatically appear when you insert clip art or pictures.

The Picture Toolbar appears when you insert an image
The investigator reached an advanced user stage and wished to add some of these toolbars to the Power Point window. Here are the steps taken by the investigator to add the animation effects toolbar.
1. The investigator clicked the View menu and then point to Toolbars.
2. In the submenu, clicked the check box next to animation effects. An animation effects toolbar appeared in the Power Point window.

![Animation Effects Toolbar](image_url)

The following steps helped the investigator to remove a toolbar.

Power Point helped the investigator even remove the toolbars which were not needed.

1. The investigator clicked the View menu and then point to Toolbar.
2. In the submenu, clicked the check box next to animation effect to deselect it.

The click mark disappeared and the animation effects toolbar was removed from the Power point window.

**Making a Multimedia learning Package**

The investigator created a *Title Slide* for MMLP using the Blank Presentation option.

The investigator worked in Slide View.

1. The Power Point program was opened. The Power Point dialog box appeared.
2. In the Power Point dialog box, the investigator clicked the Blank Presentation option button. The New Slide dialog box appeared. It asked to choose an Auto Layout format.
3. Then the Title Slide layout was clicked. It was first in the list. The name Title Slide appeared in the preview box.
A good way to start any presentation is with a title slide

4. After clicking OK, a Title Slide appears, ready for you to work with.

The Power Point dialog box appeared only when the investigator first launch the program. When the investigator already working in Power Point and want to create a new blank presentation, then the new button on the Standard Toolbar was clicked and the steps were followed:

1. The investigator clicked the File menu and then clicked New.
2. In the New Presentation dialog box, clicked Blank Presentation and clicked OK.
The Slice Layout contains text boxes for a title and a subtitle. The investigator typed text in it these boxes.

1. Clicked in the Title text box. A thick gray border appeared around the text box indicating that it was selected.
2. Type a title.

3. Click the subtitle text box and typed s subtitle.

**Following steps were taken for Adding another slide**

1. The investigator clicked the New Slide button on the Common Tasks toolbar.
2. Then the Auto Layout dialog box appeared and from there a layout was chosen for the next slide.

While developing MMLPs, the investigator used a lot of text so choice of the right kind of font/its color/ size could make or mar a presentation.

Since a window variety of fonts was available for experimenting, it was lots of fun to try out different fonts. Considering there were thousands of fonts out there, the investigator could end up making some pretty wacky choices for the MMLPs—making an entire MMLPs loaded with varied font’s might be fun for the creator, but it could not end up being difficult— if not impossible— for the pre-service teachers, our audience to comprehend. For this reason, it was important to choose the fonts very carefully.

If a presentation contains a lot of text, it’s good to use a font such as Time New Roman, which is known as “serif” font. A “serif” is a small, decorative mark that finishes off the stroke of a letter. There are also other fonts called “sans-serif”— which means: without serif. “Sans”— as you may recall form French class— means “without”. In general, it is easier to read a large amount of text when a serif font is used. Sans-serif font also tend to create a more casual, less formal impression.

If you want to use different fonts within the same presentation, it’s best to keep it down to only two or three. Using a smaller number of fonts will keep things orderly; too many different types may make it all a bit too chaotic. Like so many things in life, you’ll just have to experiment before you know what works best.

When the investigator was trying to decide which font to use, consider how they will look on screen. It was found some fonts— like Verdana— tend to look better on a computer monitor. Other fonts are more suited to print. The investigator had to see if the font was visible on a computer screen or digital projector. The investigator also had to see if the font still looked when the presentation was printed out.
Moving from slide to slide

To move to a previous slide, the investigator followed these steps:

1. By clicking the upper double-arrow button on the lower right corner of the Power Point window. The previous slide appeared.

To move to the next slide:

1. Clicking the lower double-arrow button on the right corner of the Power Point window.

Switching to Outline View

To switch to Outline View, the Outline View button in the lower left-hand corner of the Power Point window was clicked.

This is what the investigator saw in Outline View:

![Outline View Screenshot]

1. Every child has a right to education and participate in all aspects of life.
2. Every student will participate in a regular homeroom with supports to individual needs provided through that classroom.
3. All students will be placed in age appropriate setting.
4. It implies all learners, young people – with or without disabilities being able to learn throughout actors to common pre-school, community educational setting with an appropriate network of support devices. 
   MHRD ACTION PLAN COVERS THE SECTORS AS STATED BELOW
   • EARLY CHILDHOOD CARE AND EDUCATION
   • ELEMENTARY EDUCATION
   • SECONDARY EDUCATION
   • HIGHER AND TECHNICAL EDUCATION
   • VOCATIONAL EDUCATION
When the investigator moved to Outline View, Power Point automatically displayed an Outline Toolbar on the left side of the window. It contained many useful tools for working in this view.

Steps followed by the investigator for adding a slide to the outline

The investigator added a new slide in Outline View the same way as in the Slide View.
2. In the New Slide dialog box, clicked a slide layout, then clicked OK. A new slide icon appeared in the outline.
To add a new slide right after a slide title:

1. The investigator placed the cursor at the end of a slide title.

2. Press the Enter key. A new slide icon appeared in the outline.

**Steps used by the Investigator for adding to the text to the outline**

If the investigator wanted to add text to a slide that was created previously, she needed to click to an insertion point in the outline and start typing.

If the investigator wanted to add text to a new slide that was created in Outline View, following steps needed to be perused:

1. Typing a title beside the slide icon.
2. After the slide title needed to press the Enter key. PowerPoint added a new slide.
3. Clicked the button on the outline toolbar to convert the new slide to a text object.

4. Now the investigator could type the text.
5. To add another bullet point, pressed Enter.
With the exception of the title slide, any text added by the investigator was formatted as a bullet point.
The investigator could get the bird’s eye view of the MMLP by moving around in Outline view
In Outline view, the investigator could see all the text that appeared on the slides and could see all the outline titles in one shot. This option could also be used to print on outline of the presentation or for check the logical flow of your titles without the distraction of extra text.

To collapse all the slides in your outline, the investigator had to take these steps:
1. On the Outline Toolbar, clicked the Collapse All button. The slide text for all the slides disappeared.

To expand all of the slide titles again:
1. Clicked the Expand All button on the Outline toolbar. The text for all the slides appeared again.
Jumping from one slide to the next

To move from slide to another in Outline View, the investigator could click anywhere in the slide that that she wanted to move to.

The investigator kept on saving the presentation at every step

While working on a presentation, it’s a good idea to save your work often. Otherwise, there was a risk of losing the work at any stage due to power failure or any other reason. The investigator kept on saving the work at every stage. The following steps were used to save the MMLPs to the hard drive. When the investigator was saving for the first time the Save AS command was used.

1.) Clicked the File menu, and then clicked the Save As. The Save As dialog box appeared.

2.) In the File name box, the investigator typed a name the MMLP (presentation).
3.) Clicked save.
The presentation now saved to the hard drive.
Once the investigator saved the presentation for the first time, periodically could Save it by clicking the file menu, then clicking Save. Or, clicked the Save button on the standard toolbar.

The AutoContent Wizard was used by the investigator for creating MMLPs.
First the investigator launched PowerPoint then clicked the AutoContent Wizard option wizard option button in the PowerPoint dialog box to start the presentation.
Following were the steps used to star the AutoContent Wizard:
1. Clicked the file menu, then click new. The New Presentation dialog box appeared

2. In the new presentation dialog box, clicked the Presentations tab.
3. In the Presentation list, click the AutoContent Wizard, and then clicked OK. The wizard got started
The investigator Worked with AutoContent Wizard

The AutoContent Wizard guided the investigator through some simple steps.
1. The investigator read the information on the start screen, and clicked next.
2. In the next dialog box, selected the type of presentation the investigator wanted to give, and then clicked Next to advance to the next dialog box.
3. Continued entering options until reached the Finish step.

The AutoContent Wizard displayed the MMLP in Outline View. The outline is made up of sample slides, each of which had a suggestion for the type of information that was to entered in the slide. So the investigator customized the information in the slides in either Outline View or Slide View.

Template used for developing MMLPs

A template, also called a presentation design, it helped the investigator to create a presentation without worrying about design elements. The templates defines the color, background, and font of the slides. PowerPoint has many templates, which the investigator could preview and select in the New presentation dialog box. PowerPoint also allowed the investigator to customize the templates. For instance, the investigator could change the background color or typeface of
the template. Investigator has used different templates for developing Multimedia Learning Package.

Creating a MMLP using templates

After the investigator had just launched PowerPoint, the Template option button was clicked in the PowerPoint dialog box to start a new presentation.

When the investigator was already working in PowerPoint, following steps were taken:

1. Clicked the File menu, and then clicked new. The New Presentation dialog box appeared.
2. Clicked the Presentation Designs tab, and then clicked an appropriate template. The design appeared in the preview box.
3. Clicked OK. The New Presentation dialog box closed.
Changing background colour of the slides in the MMLPs

In the PowerPoint it’s easy to change the background colour of the slide, the investigator was working on. If the investigator wanted to change the colour of the slide top light blue, here’s what she needed to do:

1. Clicked the Format menu, and then clicked Background. The Background dialog box appeared.

![Background dialog box](image)

2. In the Background fill section, clicked the arrow on the list box to open it.

3. Clicked More colours to open the Colours dialog box.

4. In the colours section, clicked the light shade of blue.

![Colours dialog box](image)

5. Clicked OK to close the Colours dialog box.

6. In the Background dialog box, clicked the Preview button to saw a preview of the slide color.
7. If the investigator licked what she saw, clicked the Apply button. The background colour of the slide was now light blue.

For changing background pattern the investigator followed these steps:
1. Clicked the format menu, and then clicked the Background. The Background dialog box appeared.
2. Clicked the Background Fill list box, and then clicked Fill Effects. The Fill Effects dialog box appeared.
3. Clicked the pattern tab, and then clicked the pattern, the investigator wanted in the Pattern box. A preview of the pattern appeared in the Sample box.

4. If the investigator wanted to change the background and foreground colors of the pattern, she had to select them from the Background and Foreground drop down lists.

5. Clicked OK to close the Fill Effects dialog box.

6. In the background dialog box, clicked the Apply button.

The investigator had a wide range of colours available to choose from

When to it came to text colours and background colours and patterns, the investigator had a dizzying array of choices. While it was possible to go crazy with them, it was best to stay on the more conservative side and create something the student's should actually read.

It was good to choose a contrast between text and background colours. For example, black text and white background is most legible. Other good
combos included white text on a dark blue or a purple background or dark blue text on a yellow background.
The investigator wanted to use background and also used patterned ones. For MMLPs- Growth and Development, Learning and Personality, the investigator designed the template using appropriate pictures. The investigator decided to keep the background as such as possible. Very jazzy patterns were avoided by the investigator since they could have made it very difficult to read text and could make the pre service teachers confused.

**Spellings Checking by using PowerPoint Spelling Checker.**

It's a good idea to check the spelling in our presentation before the audience sees it. The investigator used the PowerPoint's spelling checker to check the presentation. When the spelling checker was activated, it checks spelling in all the slides.

1. On the standard toolbar, clicked the spelling button.

2. If the spelling error detected was detected a Spelling dialog box appeared.
3. The Spelling checker suggested an alternative spelling in the Change to box. An additional list of suggestions also appeared below the box.
2. If the investigator wanted to continue without changing the spelling, click ignore.
3. If the investigator wanted to change the spelling, entered one of the suggested alternatives in the Change to box, then clicked Change.

After the investigator had made the selection in the spelling dialog box, the spelling checker continued checking the remaining slides. When it had checked all the slides in the presentation, a message box appeared telling that the spell check was complete.

The investigator could even turn the automatic spelling checker off

As the investigator typed, a red wavy line appeared under misspelled words. If the investigator wanted to correct the spelling immediately, then with a right-click of the mouse on the word, and a menu appeared suggesting spelling alternatives.

If the investigator didn’t wanted to see any wavy red lines under misspelled words as they were typed, the automatic spelling checker turned off.

1. Click the Tools menu, and then clicked Options. The Options dialog box appeared.

2. Clicked the Spelling tab.
3. Under check spelling as the investigator typed, clicked the spelling check box to deselect it. The check mark disappeared.
4. Clicked OK to close the Options dialog box. The automatic spelling checker got deactivated.

Even when the automatic spelling checker was turned off, the main spelling checker still worked. So the investigator could check the spelling in the presentation at any time by clicking the spelling button on the Standard toolbar.

The investigator had to decide about going for spell check or not to spell check. Spell check should be done or not?

Using the spell checker was a good way to maximize the use of time- the most precious resources. It was pretty nice and comfortable to just sit back as the computer scanned the document. The downside was that the investigator might have used a wrong word- spell correctly-and computer couldn’t point out such errors. The advantage of not using spell check was that it forced the investigator to be more careful about the spellings. So the spell checker was avoided by the investigator since it looked more like a crutch that could have many words wrongly placed and spelled.
Adding a new text box

Sometimes, the investigator has added text to a slide without using a built-in text box. For example, to type a label for a drawing, the investigator added text box using following steps:

1. On the drawing toolbar, clicked the Text Box button. The pointer changed to a cross.

2. Click on the slide where the investigator wanted to place the text. A small text box appeared.

3. Typed a word in the text box. As the investigator typed, the box expanded to fit the text.
4. After the investigator finished typing, clicked outside the text box. The border around the box disappeared.

**Moving a text box**

The investigator followed the following steps to move a text box:

1. Clicked the text box the investigator wanted to move. A thick gray border appeared around the text box.
2. Placed the pointer on the border. The pointer was changed into a four headed arrow.

3. Hold down the mouse button and dragged the box to the new location.
4. Release the mouse button.

**Adding colour to a text box**

1. Click the text box to select it.
2. On the drawing toolbar, clicked the arrow beside the Fill Colour button, and then clicked the green colour box. The text box turned green.
Changing the font

The investigator used the following steps to change the font.

1. Clicked the text box to select it.
2. Placed the pointer on the box’s border, and clicked again. The insertion point disappeared, indicating that entire text box was selected.
3. Clicked the format menu, and then clicked Font. The font dialog box appeared.
4. In the font style list, clicked bold; in the Size list, clicked 36; and in the Color list, clicked green.
5. Clicked OK to close the font dialog box.

All the text in the box is now green, bolded, and a font size of 36.

Adding a shape

PowerPoint lets you add a variety of shapes to the slides of your presentation.

Adding a star shape to the slide, using the AutoShape tool on the drawing toolbar.

1. Clicked the AutoShapes button, point to Stars and Banners, and then click the 5-point star shape. The pointer was changed into a cross.
2. Clicked anywhere on the slide. A star of predefined size will be inserted.
   - To make the shape larger (or smaller), drag a resizing handle. To resize the shape proportionally, hold down the SHIFT key as you drag.

**Adding color and texture to a shape**

Adding the colour yellow to the star.

1. Clicked the star shape to select it.
2. Clicked the arrow beside the Fill Colour button, and then clicked More Fill Colours.
   A colour dialog box appeared

3. Clicked the Standard tab, then under Colors, clicked a shade of yellow.
4. Clicked OK to close the Colors dialog box.

Next, adding some texture to the shape:
1. Clicked the star to select it.
2. Click the arrow beside the Fill Color button, and then clicked Fill Effects. The Fill Effects dialog box appeared.
3. Clicked the Texture tab.
4. Clicked on a texture, and then clicked OK.

Adding clip art
The investigator followed the following steps to add a cartoon image to the slide:
1. on the Drawing Toolbar, clicked the Insert Clip Art button.
2. the Microsoft Clip gallery dialog box appeared.
3. Clicked the Clip Art tab.
4. In the categories list, clicked Cartoons. PowerPoint displays clip art from the Cartoons category.

5. Clicked an image to select it.
6. Click the Insert button. The cartoon image was inserted on the slide.
Resizing clip art

Like text boxes and shapes, it was easy to change the size of a clip art image. Here’s how:

1. Clicked the cartoon image to select it.
2. Place the pointer on the resizing handle. The pointer changed into a two-handed arrow.
3. While holding the mouse button, dragged the mouse outwards to enlarge the image. If the investigator dragged the mouse inwards, the size of image was reduced.

4. When the image was the size the investigator wanted, release the mouse button.

**Adding a transition**

A transition is a special effect used to introduce a slide during a slide show.

The following steps were used by the investigator to add a transition to a slide.

1. In Slide Sorter View, clicked the slide the investigator wanted to add the transition
3. In the Effect list box, clicked Checkerboard Across.
4. Clicked the Modify option button to select a speed for transition.
5. Clicked the Apply button. A slide transition icon appeared under the slide’s left corner, indicating that the transition has been applied.

To apply the same transition to all slides in the presentation, clicked the Apply to All button in the Slide Transition dialog box.

**Timing a transition**

To run slide show automatically, timing was added to the slides.

Here’s how the investigator added timing to the slides:

1. Selected the slide to add timing to by clicking it.
2. In Slide Sorter View, clicked the Slide Show menu, and then clicked Slide Transition. The Slide Transition box appeared.
3. Under Advance, clicked the check box next to Automatically After.
4. In the second box, typed the number of seconds to remain on the slide. For example, 5 seconds.

5. Clicked the Apply button.

**Adding Sound**

There were different methods to add sound in the PowerPoint. The investigator wanted to use her own voice and also wanted to add background music to it. So she choose to record her voice using sound recorder and after mixing it with background music, added it to the PowerPoint.

The following steps were taken by the investigator to record her voice:

1. **Launching Sound Recorder**
   - In Windows XP, navigated to `Start > All Programs>Accessories>Entertainment>Sound Recorder`.
   - When the Sound Recorder propped on screen, the investigator noticed that it looks a bit like a tape recorder front panel.
   - In the center of the window was a flat, green line. As the sound played or records, this green line oscillates to visually represent the sound.
   - To the left was the *Position* indicator, represented in hundredths of a second.
   - To the right was the *Length* indicator, showing the total duration of the sound file.
   - Below these features was a *Slide Bar* indicator that shows where the sound file was playing, relative to its overall length.
   - Finally located below the Slide Bar, the investigator saw the universal symbols (from left to right) for Rewind, Fast forward, Play, Stop, and Record.
2. **Setting the Microphone Record Level**

Before beginning recording the investigator checked the microphone setting for a proper volume level.

1. After starting Sound Recorder, clicked on Edit Audio Properties.
2. In the Audio Properties dialog box, under the sound Recording section, checked to see that the sound card was the Default device.
3. Below the Default device, clicked on Volume.

4. In the Recording Control dialog box, the investigator selected the microphone as the recording source, and turned its volume up full.
5. Close the dialog box and returned to the Audio Properties box.
6. Clicked OK.

3. **Recording a Sound**
   To record and play audio, the investigator needed a sound card, a microphone, and speakers or headphones. To record the voice, the investigator hooked the microphone into the audio-in-jack on the computer’s sound card.
   1. On the **File** menu, clicked **New**.
   2. To begin recording, clicked and speak into the microphone.
   3. To stop recording, clicked .
   4. To continue recording, clicked and speak into the microphone again.
   5. When finished, clicked to stop recording.
   6. On the **File** menu, clicked **Save As**. Type a new name for the file, selected the location to save the file, and Clicked the **Save** button.

4. **Adding Effects to a sound file**
   The effect tools are located in Sound Recorder’s **Effects** menu.

![Sound Recorder Effects Menu]

**Increase Volume**
This increases the volume by 25%. (However, investigator can select this option twice for a 50% increase, three times for a 75% increase, and so on.)

**Decrease Volume**
This decreases the volume by 25%.

**Increase Speed**
This doubles the rate of a sound’s playback.

**Decrease Speed**
This slows the rate of a sound’s playback by 50%.

**Add Echo**
This adds an audio reverb.

**Reverse**
This reverses the sound so it can be played backward.

**Adding sound to animations**
The investigator has added sound to MMLPs by using the following steps:

1. In Slide View, selected the animated object that the investigator want to add the sound effect to by clicking it.
2. Clicked the Slide Show menu, and then clicked Custom Animation.
3. Under Entry animation and sound, selected a sound effect from the drop-down list.
4. To preview the sound effect, clicked the Preview Button.
5. Clicked OK to add the sound to the animation. The sound was added to the animated object.

Adding sound to transitions
The investigator has added the sound files in the Presentation using following steps:
1. The Slide Sorter View, clicked the slide with the transition the investigator were adding sound to.
2. Clicked the Slide Show menu, and then clicked Slide Transition. The Slide Transition dialog box appeared.
3. Selected a sound effect from the Sound drop-down list, then clicked Apply. The sound was added to the transition.
   To continue playing until the next sound in the presentation, clicked the check box next to ‘Loop until next sound’.

Adding a video clip
The investigator has also added video clip to the presentation. The following are the steps used to add video clip in the presentation.
1. Click the Insert menu, point to Movies and Sounds, and then clicked Movie from File. The Insert Movie dialog box appeared.

2. In the Look in box, located the drive and folder where the investigator has saved the video clip.

3. Selected the video clip file from the file list, and then clicked OK. A video screen icon is added to the slide.

3.3.2.5 Story Boarding
The researcher had collected the information, organized it sequentially. Now it was further enriched with various multimedia elements to make it more effective. At this stage the researcher decided about the placing of various elements in various steps or
parts of MMLP, it was more about the arrangement of the content for the presentation purpose. The researcher decided about the background music input, fading in and fading out of the text and image on the slides of MMLPs. A smooth transition was also worked out at this stage. (Appendix-H)

Table 4.13
Learning Objectives
Topic: Environment and Natural Resources: Water

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define Environment, Resources.</td>
</tr>
<tr>
<td>2</td>
<td>Understand the differences between Renewable and Non-Renewable resources.</td>
</tr>
<tr>
<td>3</td>
<td>Understand and explain the different types of resources.</td>
</tr>
<tr>
<td>4</td>
<td>List out the examples of renewable and non-renewable resources.</td>
</tr>
<tr>
<td>5</td>
<td>Give examples of different types of Natural Resources.</td>
</tr>
<tr>
<td>6</td>
<td>Explain the presence of water on earth.</td>
</tr>
<tr>
<td>7</td>
<td>List out the different sources of water.</td>
</tr>
<tr>
<td>8</td>
<td>Explain the importance of water.</td>
</tr>
<tr>
<td>9</td>
<td>List examples of eatables having water as constituent.</td>
</tr>
<tr>
<td>10</td>
<td>Define photosynthesis</td>
</tr>
<tr>
<td>11</td>
<td>Understand the process of photosynthesis and transportation.</td>
</tr>
<tr>
<td>12</td>
<td>Cite examples of the uses of water at work, at home and at play.</td>
</tr>
<tr>
<td>13</td>
<td>Define Water Cycle.</td>
</tr>
<tr>
<td>14</td>
<td>Draw and explain the water cycle.</td>
</tr>
</tbody>
</table>
Environment and Natural Resources: Water

Objective Questions

Define Environment, Resources

Types of Resources and Water on Earth. Importance of Water.

Text
Images
Sound
Animation

Environment and Natural Resources: Water

Figure 4.9 Story Board of Multimedia Learning Package (Environment and Natural Resources)
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define Atmosphere.</td>
</tr>
<tr>
<td>2</td>
<td>List out the different layers of atmosphere.</td>
</tr>
<tr>
<td>3</td>
<td>Understand the differences between layers of atmosphere.</td>
</tr>
<tr>
<td>4</td>
<td>Understand the composition of air.</td>
</tr>
<tr>
<td>5</td>
<td>State the examples of activities in different layers.</td>
</tr>
<tr>
<td>6</td>
<td>Understand and explain the balance of proportion of gases in atmosphere.</td>
</tr>
<tr>
<td>7</td>
<td>Explain and understand the Oxygen cycle in atmosphere.</td>
</tr>
<tr>
<td>8</td>
<td>Explain and understand the Nitrogen cycle in atmosphere.</td>
</tr>
<tr>
<td>9</td>
<td>Define nitrogen fixation, nitrification and denitrification.</td>
</tr>
<tr>
<td>10</td>
<td>Explain and understand the Carbon cycle in atmosphere.</td>
</tr>
<tr>
<td>11</td>
<td>Draw and explain the bio geo chemical cycles</td>
</tr>
<tr>
<td>12</td>
<td>Define the ozone layer.</td>
</tr>
<tr>
<td>13</td>
<td>Explain the ozone layer with its harmful effects.</td>
</tr>
<tr>
<td>14</td>
<td>Cite examples of air in motion.</td>
</tr>
<tr>
<td>15</td>
<td>Understand the importance of air in atmosphere.</td>
</tr>
</tbody>
</table>
Environment and Natural Resources: Air

- Definition & layers of Atmosphere
  - Text
  - Images
  - Sound
  - Animation

- Explain the Bio-Geo Chemical Cycles
  - Text
  - Images
  - Sound
  - Animation

- Importance of Air, Objective questions
  - Text
  - Images
  - Sound
  - Animation

Figure 4.10 Story Board of Multimedia Learning Package (Environment and Natural Resources-Air)
### Table 4.15

**Learning Objectives**  
**Topic: Environment and Natural Resources: Soil**

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define soil.</td>
</tr>
<tr>
<td>2</td>
<td>Understand the characteristics of different layers of soil.</td>
</tr>
<tr>
<td>3</td>
<td>Understand the difference between layers of soil.</td>
</tr>
<tr>
<td>4</td>
<td>Recognize the different types of soil in India.</td>
</tr>
<tr>
<td>5</td>
<td>List out the crops grown in different types of soil.</td>
</tr>
<tr>
<td>6</td>
<td>Explain the characteristic of different types of soil.</td>
</tr>
<tr>
<td>7</td>
<td>List out the resources found in soil.</td>
</tr>
<tr>
<td>8</td>
<td>Describe the importance of soil.</td>
</tr>
<tr>
<td>9</td>
<td>Draw the different horizons of soil.</td>
</tr>
<tr>
<td>10</td>
<td>Recall how soil helps in maintaining water table.</td>
</tr>
</tbody>
</table>
Figure 4.11 Story Board of Multimedia Learning Package
(Environment and Natural Resources-Soil)
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define Forest.</td>
</tr>
<tr>
<td>2</td>
<td>Recognize the area under forest on earth.</td>
</tr>
<tr>
<td>3</td>
<td>Recall the types of forests.</td>
</tr>
<tr>
<td>4</td>
<td>Explain the characteristics of each type of forest.</td>
</tr>
<tr>
<td>5</td>
<td>Understand and differentiate between different types of forest.</td>
</tr>
<tr>
<td>6</td>
<td>Cite examples of plants found in different types of forests.</td>
</tr>
<tr>
<td>7</td>
<td>Understand and explain the importance of forests.</td>
</tr>
<tr>
<td>8</td>
<td>Define water table, soil erosion.</td>
</tr>
<tr>
<td>9</td>
<td>List the products available from forests.</td>
</tr>
<tr>
<td>10</td>
<td>Cite examples of plants used for curing diseases.</td>
</tr>
<tr>
<td>11</td>
<td>Analyze the importance of food chains found in forest.</td>
</tr>
<tr>
<td>12</td>
<td>Discuss how forest helps in water cycle and transpiration of plants.</td>
</tr>
<tr>
<td>13</td>
<td>Recall the forest as source of recreation..</td>
</tr>
</tbody>
</table>
Figure 4.12 Story Board of Multimedia Learning Package
(Environment and Natural Resources- Forest)
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define Pollution, Pollutants.</td>
</tr>
<tr>
<td>2</td>
<td>Describe the sources of pollution of water, air, soil and forest.</td>
</tr>
<tr>
<td>3</td>
<td>List out the various sources of pollution of water, air, soil and forest.</td>
</tr>
<tr>
<td>4</td>
<td>Define acid rain. Rain water harvesting. Global warming, Green house effect. Soil erosion, over grazing deforestation, afforestation, Green revolution and fertilizers.</td>
</tr>
<tr>
<td>5</td>
<td>Differentiate between the different types of cultivation.</td>
</tr>
<tr>
<td>6</td>
<td>Give examples of things destroyed by acid rain.</td>
</tr>
<tr>
<td>7</td>
<td>List out the harmful effects of acid rain and depletion of ozone layer.</td>
</tr>
<tr>
<td>8</td>
<td>Give examples of diseases caused by water pollution.</td>
</tr>
<tr>
<td>9</td>
<td>Define Vanmohatsav and Chipko movement.</td>
</tr>
<tr>
<td>10</td>
<td>Describe the steps taken by government to purify the rivers of India Ganga and Yamuna.</td>
</tr>
<tr>
<td>11</td>
<td>Able to formulate the reasons for environmental degradation.</td>
</tr>
<tr>
<td>12</td>
<td>Able to analyze how to conserve water in agriculture.</td>
</tr>
<tr>
<td>13</td>
<td>Able to list the measures for conservation of air by reducing air pollution.</td>
</tr>
<tr>
<td>14</td>
<td>Able to list the measures for conservation of soil.</td>
</tr>
<tr>
<td>15</td>
<td>Apply the usage of 3R’s in environment i.e. Recycle, Reduce and Reuse.</td>
</tr>
<tr>
<td>16</td>
<td>Give examples of various products procured from the forest.</td>
</tr>
<tr>
<td>17</td>
<td>Understand the reasons for protecting the forest and soil.</td>
</tr>
<tr>
<td>18</td>
<td>Explain the reasons for National Parks and Wild Life Sanctuaries.</td>
</tr>
</tbody>
</table>
Consequences of Human Activities and Steps for Conservation of Natural Resources

Define Pollution and its sources

Text
Images
Sound
Animation

Consequences of Human Activities and Steps for Conservation of Natural Resources

Human activities causing pollution of natural resources

Text
Images
Sound
Animation

Steps for Conservation of Natural resources.

Text
Images
Sound
Animation

Figure 4.13 Story Board of Multimedia Learning Package
(Consequences of Human Activities and Steps for Conservation of Natural Resources)
3.3.2.6 AUTHORING

In case of MMLPs the page the page base and time based authoring tools have been used where content is conceived as a sequence of pages or frames. So MMLPs can be visualized as a sequence of pages of frames which contain media elements embedded in them. Like every page of the book each frames continued many media elements like- test, video, audio and animation. The instructor could always manually visit the slides in any sequence. Figure 4.14
3.3.2.7 DATA DELIVERY

The MMLPs was developed by the researcher and written on the DVDs and pen-drives which was presented by the researcher to the teachers. These MMLPs were also shown to the experimental Group of class VII students.

Try-Out of the MMLPs

After development, the Multimedia Learning package was tried out on 70 students of class VIII to obtain their response regarding the effectiveness of the lessons to be delivered by the multimedia method of instruction to achieve environmental awareness in environmental Science.

Validation of MMLPs

Validation (or testing) is a painstaking procedure but an essential part of the total quality assurance process. It is the study of effectiveness of design prototypes, acknowledging any weaknesses encountered. The purpose of validation was to check if the program could meet its specified objectives. Realizing the objectives of the validation process required clear testing procedures to be devised. Responses of educator to the MMLPs and scores on the post-test indicated that they were instructionally sound. Changes were made when needed with respect to sequence, content, presentation and clarity in language. The valuable suggestions of 13 Environmental Science and other Science teachers and Educational Technology Experts were also incorporated thereby ensuring content and construct validity. MMLPs were again reviewed and thus the final draft of MMLPs was accepted and presented to the experimental group in the study. List of experts is given in (Appendix-L)

170
4.4 SETTING UP MULTIMEDIA STUDIO

Before embarking on the journey of developing MMLP’s the instructor thought of the approach to be adopted and laid out a plan of action. For setting up a Multimedia Studio it was necessary for the researcher to have an understanding of the following-

1. Knowledge and understanding of various medias- software and hardware
2. Listing and understanding of various mediums.

4.5.1 HARDWARE AND SOFTWARE REQUIREMENTS

The researcher began with setting up and tuning up Multimedia Hardware in such a manner so that a well equipped multimedia studio could be set up. The researcher studied and found that there were two distant kinds of multimedia hardware available in the market:

1. Those with multimedia enabled motherboards- requiring little or no additional multimedia peripherals.
2. Those build with additional multimedia peripherals.

So the researcher could choose to buy a motherboard with audio input and output capabilities and thus save some cost on buying an external sound card or even could choose to buy a basic motherboard without multimedia capabilities. and later on, add favorite sound card to it. The computer with Motherboard integrated multimedia was selected with a dedicated sound card with advanced capabilities to create next generation audio effects for MMLPs.
AGP I Graphics accelerator cards were used as an interface between the computer and monitor. While AGP cards merely handled the colour display and resolution, graphics accelerators helped in sophisticated graphics acceleration. So AGP cards helped in getting better visuals and performances in MMLPs.

The sound cards or the audio cards managed almost all possible kinds of audio includes digital audio and mp3 etc. The researcher also used a pair of speakers or headphones for audio recordings. And of course, two good ears to actually hear the sounds as they come out of a sound card.

The CD Controller Cards were used to handle CD-ROM/CD-R Drives.

Video Capture Boards were used by researcher to capture video contents from VCRs and Handy cams into the computer, in digital video format.

VGAs and PAL I NTSC Converter Cards used to convert PC to TV.

Multimedia software

The term multimedia software is very generic and conceptual in nature. Theoretically, any type of software performing multimedia function or other can be termed as...
multimedia software. It encompasses a wide variety of tools, applications, packages, devices drives and other utilities-all related to multimedia, in one way or the other.

**Figure 4.16 Multimedia Software Tools**

**Multimedia Software Tools** - the following multimedia software were required for MMLPs development:
- Device Driver Software - meant for installing and configuring multimedia peripherals.
- Media Player - meant for handling multimedia file formats
- Media Conversion Tools - means for encoding/decoding multimedia contents and for converting one file format to another.
- Media Editing Tools - meant for creating/editing multimedia data.
- Multimedia Authoring Tools - meant for combining different kinds of media formats and deliver them as multimedia contents.

While developing MMLPs Multimedia Applications were created with the help of above mentioned Multimedia Software Tools and Packages.

**External multimedia equipments used by the researcher for developing Multimedia Learning Packages**

Apart from all those add-on cards that is listed in the above section, some external multimedia equipment was used to carry out the tasks. Some of them were:
Similar to multimedia peripherals, not all of the above listed equipments were required for all the MMLPs. It all depends upon the nature of Multimedia Learning Package and activities involved.

How the right multimedia peripheral and equipments were chosen-
Given the myriad of brands and products available in multimedia peripherals category, it was but a complex exercise to choose the best products among the lot and to identify those that provided professional services and offer good value for money.
A good starting point, before buying any piece of multimedia hardware, the researcher checked up IT magazines and websites and caught hold of reviews/comparisons about the product. The researcher studied some data in the periodicals that provided monthly research results and offered information on multimedia hardware and the best of the breeds available in all categories.

4.5.2 MULTIMEDIA FORMATS AND THEIR FUNCTIONALITY

The selection of the most common multimedia formats required a great care because when the researcher selected a format, also needed to time it judicially only then it could make the entire presentation could be made effective. There was no overlapping of any particular element since it could cause overdosing. Animation makes a presentation effective and moving image have the multiple uses, but a screen should not include permanently moving animation so not to distract the user from interpretative text. The various formats of multimedia were used by researcher independently or in combination with another in the right proportions. The choice of the format largely depended upon the nature and objectives of the concept and the availability of resources, time budget, 2-D and 3-D animation facilities for the multimedia programmes. Furthermore, it may be noted that though Multimedia Package can be a powerful learning and teaching tool because it engages multiple senses, but its success or failure largely depends on the teacher using it. Multimedia package create a better learning environment and the students actively participate in the class. So the Multimedia Learning Package can prove to be an effective tool in the hands of teacher if, it is rightly used in the class.

4.6 OVERVIEW

It was envisaged that the use of standardized tools like Intelligence test and Socio-Economic Status Scale measured the students on equal standards and the three-fold self developed tools namely- Achievement Test on Environmental Awareness, Opinionnaire for teachers and Multimedia learning Package would provide enough data to examine the effectiveness of multimedia in its minutest details. It helped to